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Label Artist-Il

1. Introduction
This Manual documents how to use the Label-Artist-II.

We at BIXOLON maintain ongoing efforts to enhance and upgrade the functions and
quality of all our products. In the following, product specifications and/or user manual
content may be changed without prior notice.

2. Supported Operating Systems
The following OS versions are supported:

Microsoft Windows XP SP3 (32 bit)

Microsoft Windows XP SP1 or later (64 bit)

Microsoft Windows Server 2003 SP1 or later (32/64 bit)
Microsoft Windows Vista (32/64 bit)

Microsoft Windows Server 2008 (32/64 bit)

Microsoft Windows Server 2008 R2 (64 bit)

Microsoft Windows 7 (32/64 bit)

Microsoft Windows 8/8.1 (32/64 bit)

Microsoft Windows Server 2012 (64 bit)
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3. Features
3-1 <File> Menu
3-1-1 New
1) Select <New:-l> from the <File> tab.
* Printer Driver must be installed in order to use "Label Artist-1I" application.

2) The dialog windows appears as below to be able to select a printer driver.
Select the printer to use and click <Next>.

Select Printer

Printer Mame Port Name

BIXOLOM S5LP-T403 Useooz

BIXOLOM SLP-DX420 UsBoo1

Test Print Mext = | ‘
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3) The <Printing Preferences> window opens as shown below.
Specify the printing options such as label size and click <OK>.

r r
Printing Preferences g Printing Preferences g
Options | Advanced Setup Options | Advanced Setup

Settings Print Method
Spead (inch per sec) Direct Thermal &) Thermal Transfer
Darkness 14 -
Media Type
Paper Size (Unit : mmy) Margins (Unit : mm}
] Gap (@) Continuous
Width 101.6 X margin 0.00
] () Black mark
Height 152.4 Y margin 0.00
Print Direction Position adjustment
@ Mo Rotation () Rotate 1807 Gap/Black-mark length : 3.00 mm
Gap/Black-mark offset : 0.00 mm
Multiple columns of kbels o/
PU— Tear-offfcutter offset : 0.00
Columns 1 % Horizontal Gap 0.0 mm ! mm
Cut Paper
= Compressed Data Transmission
Never v] Interval :
Reverse feeding

Lo [ o] [o

4) Once the preferences are set, a new label is created.

T BT BT O I O BRI AL IR B B |14o| T O IO N B W
TSN Ty Y e R T T s s et T e T YA T ] T T e AP T e et K e

Label Artist-II Paper Width: 101.6 mm Paper Height: 152.4 mm

Rev. 1.01 -4-



Label Artist-Il

3-1-2 Open
1) Select <Openl= > from the <File> tab.

2) When the “Open” dialog is shown as below, select one of the files saved previously
(*.lafx) and click [Open].

- Open
v| 10 % Documents v MylabelArtist - | 4—,.| Search MyLabelArtist pel |
Organize New folder =+ [ @

-

V¢ Favorites Documents library

: Arrange by:  Folder «
B Desktop MyLabelArtist
8 Downloads MName Date modified Type
5| Recent Places
[l MyLabel.lafx 1/4/20156:43 PM  Label Arti
s Libraries
@ Documents
Jﬁ Music
[&] Pictures
B videos
Ll Computer
€ MNetwork * < m | >
File name: MyLabellafx [ Label Artist-TFiles ("Jaf ~|
I Open Ivl I Cancel ]

3) The content of the file is shown as below.

|x|

. - Mylabel lafx - Label Artist-Il
Setting  View Help
D e %@ ABNDOO0 =] (-9 ¢ %30 ES Q|2 Fd & 4|

mm 10| 20| 20| <0 S &0 110 120 (120 120 15| 19| 170 180 20| i

Text

TN e
=

10|

20

30|

50

G0

70

1234367850

80

an

fulels]

(110]

(130 120

(40|

B
o 150

el Artist- Paper Width: 101.6 mm Paper Height: 152.4 mm 100%
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3-1-3 Save

1) Select <Save = > from the <File> tab to save your progress.

Label Artist-Il

2) The dialog window opens as shown below when <Save As> is selected.
Specify the location and name of the file to be saved and click [Save] to save the label
you created.

Rev. 1.01

£ SaveAs @
r YW R z - o |
borflns) | , « My Documents » MylabelArtist v|¢,|| Search MyLabelArtist 2
Organize « New folder .;@.
' Favorites Documents library _
Folder «
Bl Desktop MylLabelArtist
& Downloads Mame ’ Type
= Recent Places
- = Mylabellafx 1/4/20156:43 PM Label Arti
= Libraries
3 Documents
J“. Music
[&=| Pictures
H Videos
% Computer |4 1 s
File name: -
Save as type: [Label Artist-1I Files (*.lafx) v]
= Hide Felders Cancel ]
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3-1-4 Print

1) Select <Print@> from the <File> tab.

2) When the [Print Setting] window opens as below, specify the number of copies to be
printed and click [Print Label] to start printing.

3) If there are any objects linked to the database, specify the record set to print the content
of the database.

- All: all rows are printed.
- Selected: the selected rows are printed.

Number of label sets: 1

Printer Information

Printer Name : BIXOLON SLP-T403

Port Mame : UsBOO2

’ Select Printer

Select record of linked database

Record set : [Selected

Record to print : 35
Ex) 1,3,5-10,20...

View Records

[] Print to File Print Label

Rev. 1.01 -7 -



Label Artist-Il

3-2 <Edit> Menu
3-2-1 Copy, Cut, Paste, Delete

1) Copy (Ctrl + C) =2
Copy the selected object (e.g. Text, Barcode, Line).

2) Cut (Ctrl + X) &
Cut the selected object (e.g. Text, Barcode, Line).

3) Paste (Ctrl + V) &
Paste the copied or cut object.

4) Delete ' #
Delete the selected object.

3-2-2 Undo, Redo

1) Undo (Ctrl + )
Undo the last action that you made on the label.

2) Redo (Ctrl +Y) &
Redo the [Undo].

3-2-3 Order

It indicates the order of drawing the objects. An object may be hidden behind.

1) Bring Forward =
Reorder the selected object and the one that overlaps it.

a O
d || O

0l 012345 0 012345
O O
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2) Send Backward 4
Reorder the selected object and the one that overlaps it.

O

0 ¥ 012345 0 ' 012345

O

3) Move To Front =
Reorder the selected object and the one that overlaps iMove all the selected objects to
the front-most level of any overlapping objects.

4) Send To Back &
Move all the selected objects to the rear-most level of any overlapping objects.
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3-2-4 Align
"Align" allows you to line up objects to a specific object.

Use the Ctrl key to select multiple objects. The selected objects are aligned to the last
selected object.

1) Align Left Sides =
Align objects to the left side of the last selected object.

UIIIIIIII ||||Illy\

12345

2) Align Right Sides =l
Align objects to the right side of the last selected object.

[ [ [
o JMVHTINE o (VT
H) 12345% 7850 [ l_Eﬁ 3134 ]'Eﬂ"l]..

- S O
Te: ject Te
O _ .ll:l O $ O

3) Align Top Sides i
Align objects to the top of the last selected object.

O m_t R
Text object | ¢
= oy
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4) Align Bottom Sides '

Align objects to the bottom of the last selected object.

mlm
Text object |$
m

Text object
O

5) Center In Horizontal Region =)
Align the horizontal center of each object to the center of the last selected object.

O
@TeXt object% 2

6) Center In Vertical Region &

Align the vertical center of each object to the center of the last selected object.

O O
Text object
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3-3 <Object> Menu
Select objects (e.g. Text, Barcode, Line) to design.

3-3-1 Text

1) Select <Text A > from the <Object> tab and drag holding the left mouse button to create
a text box with the default attributes.

2) Double-click on the text object to open a dialog window where you can change its
attributes.

Text Properties @
Text
Link Dat:
Font
Typeface : Times Mew Roman - Sze: 26 -
Bold Italic Underline

Rotation

@ No Rotation Rotate S0 Rotate 180 Rotate 270

Lock
Use Auto-counter
[ OK ] | Cancel |

3) Set the font type and other attributes and click [OK] to apply the changes.

4) Use Auto-counter
Check “Use Auto-counter” to open the Auto-Counter Properties window as shown below.

Auto-Counter Properties @
Start value
1]
Prefix { Suffix
Prefix Link Database
Suffix Link Database

Counter Settings

Step value : 1 s Counter field length : 1
Preview
1l & a4
Apply Last Counting Value [ QK l | Cancel |

When “Auto-counter” is applied, the text changes to the [Start Value].

* Check [Apply Last Counting Value] to change [Start Value] to the next value of the last
counter set after printing.
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3-3-2 Multi-line Text

"Multi-line Text" allows you to enter text in several lines. =

3-3-3 Barcode

create a barcode with the default attributes.

2) Double-click on the text object to open a dialog window where you can change its
attributes.

Barcode Properties [

Barcode Data

Codabar - -
Code?1 1234567890 " -
Code128 i Link Database
Code128A
Code128B
gggg;SSC i (g (U8t | i) EELIE 3512 mm
Code93 Guard Bar:  2.85
Eit[a;\j‘lgamx HRI{Humzn Readable Interface)

Eimg Typeface : ‘Times MNew Roman -
EANS FontSize: & -
Industrial 2of5

Interleaved 20f5 Pasition : Below the Barcode -

LOGMARS <

mm

Rotation

Use Auto-counter Configuration @ Mo Rotation 1] 180 270

Lock [ oK l ‘ Cancel |

3) Set the barcode type and other attributes and click [OK] to apply the changes.

4) Use Auto-counter
Check “Use Auto-counter” to open the Auto-Counter Properties window as shown below.

Auto-Counter Properties @

Start value

Prefic / Suffix

Prefix Lin

Suffix Lin

Counter Settings

Step value : 1 = Counter field length : 1 =
Previaw
1,2,3,;4,5
Apply Last Counting Value [ QK l | Cancel |

When “Auto-counter” is applied, the text changes to random data.

* Check [Apply Last Counting Value] to change [Start Value] to the next value of the last
counter set after printing.
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3-3-4 Line

1) Select <Line™=> from the <Object> tab and drag holding the left mouse button to draw
a line.

2) Drag holding the Shift key to draw a diagonal or straight line.

3) Double-click on the object to open a dialog window where you can change its attributes.

Line Properties @

&

Line Thickness: | @ =1l nt
Length : 23.02 mm

Type : —_—

Lock [ OK ] | Cancel |

4) Set the line type and other attributes and click [OK] to apply the changes.

3-3-5 Rectangle, Ellipse

1) Select <Rectangle|:|> or <EIIipseO> from the <Object> tab and drag holding the left
mouse button to draw a shape.

2) Drag holding the Shift key to draw a shape with the same width and height.

3) Double-click on the object to open a dialog window where you can change its attributes.

Ellipse Properties @
Line Thickness : B = ot
Wwidth :  32.81 e
Height:  27.25 mm
Lock [ oK ] | Cancel |

4) Set the line type and other attributes and click [OK] to apply the changes.

Rev. 1.01 -14 -



3-3-6 Picture

Label Artist-Il

1) Select <Picture=l> from the <Object> tab to open a dialog window where you can

select an image file.

= Libraries
3 Documents

;J'- Music
=] Pictures

B videos

1% Computer

&i Metwork

m

« Open @
uu | .« Documents » MylabelArtist - |$,| Sec g
Organize « Mew folder =« O I@I
't Favorites — Documents library . _ _
; Arrange by: Folder «

Bl Desktop MyLabelArtist

& Downloads Mame . Date modified Type

ol Recent Places

=] lenna.jpyg 8/18/2013 6:24 PM  JPEG imat

- 4

File name:

m

3

~  [IPEG File (*JRG;JPEG, JPE"JF ~|

) |

[ Open Cancel ]

2) Select an image file, click “Open” and drag holding the left mouse button to place the

image on the screen.

3) Double-click on the object to open a dialog window where you can change its attributes.

HalfToning

[Ermr Diffusion

Picture Dimensions

Wwidth :

Height :

DPercenGge of

Original Size

Lock

Rotation

) No Rotation
(@ Rotate 30
) Rotate 180

) Rotate 270

l [ Cancel

4) Set the type and other attributes and click [OK] to apply the changes.

3-3-7 Misc.

Lock: enable this feature in the dialog window where you can set the attributes of each

object.

- The locked objects cannot be moved or resized.

Rev. 1.01
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3-4 <Database> Menu

3-4-1 Connect Database

1) Select <Connect Database> from the <Database> tab.
Select the type of database to use and click “Next”.

Database Setup Wizard @

Select the type of database file

@ Microsoft Excel File(*.xls, *.xlsx)

) Microsoft Access File(*.mdb, *.accdb)

© Text File(*.bxt)

Delimitation : | Tab

Click “Browse” to select a database file as shown below.

ol
-

Database Setup Wizard | 23 |
Browse the file which you use.
C:\Users\DTMLLUAdminUser\Documents\MyLabelArtist\DE_Data.xls
Select the table that you would ke to read. |Sheet1s v]

Nurmber Mame Price i

1 Apple 250 A

2 Pear 280

3 Orange 800

4 MNoodle 123

5 Dasida 10000

6 MNewspaper 500

7 Tickets 15200

8 Apple 5000

g Pear 3000

10 Qrange 20000 i

Ceme ] o]

Select a table and click “Finish” to use the database file when designing a label.

* Make sure to disconnect the current database to use another one.

Rev. 1.01
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3-4-2 Disconnect Database

Label Artist-Il

Select <Disconnect Database> from the <Database> tab to disconnect the database.

3-4-3 Link DB

Check “Link Database” in the <Text> or <Barcode> dialog window.

Text Properties @ Barcode Properties ==
[ Link Database -
- Code128A
Code128B
Font gggﬁ;ggc width: 020 [5] o egnt: 358
: A = 5 Code9d3 Guard Bar: 265
Typeface : ITlmes Mew Roman I Size : - DataMatrix mm
EAN13 HRI(Human Readable Interface)
2 EAN2 ; "
[ Bold [ Ttalic [C] Underline EANG Typeface : [ Times Hew Reman v
EANS FontSize: 9 -
Rotation Industrial 205
@ No Ratation ©) Rotate 90 ©) Rotzte 180 ©) Rotate 270 Interleaved 20f3 Postion :
) ) ) ) LOGMARS .
Rotation
[FLock [Juse Auto-counter Configuration ®No Rotation  © 90 ©180 ®270
[[luse Auto-counter Configuration
e

Select a field you want to use from the field list.

Link Database Wizard @
Database fie
C:\Users\DTMLLUAdminUser\Documents\MyLabelArtist\DB_Data.xls
Datatable :  Sheetlf
Field list : | Number -
Data format : Sheetls.Humber
Number Hame Price ™
1 Appla 250
2 Pear 280
3 Orange 800
4 Hoodle 123
3 Dasida 10000
6 Mewspaper 500
7 Tickets 15200
g Appla 5000
9 Pear 3000 -
l oK l l Cancel I

When a text object is linked to the database, the following message appears.
WorkSheetName.FieldName
Ex) Sheetl1$.Num

When a barcode object is linked to the database, a barcode with random data is created
on the screen.
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3-5 <View> Menu

1) Zoom In
- Enlarges the view of the entire layout by 20%.

2) Zoom Out
- Reduces the view of the entire layout by 20%.

3) 100% Size
- Returns to the original size.

4) Fit to the height
- Enlarge/reduce the view to fit the height of the screen.
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